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Outline for the Short Course 

A quick overview of R and R Commander

Loading R Commander into an R Session

Exploring the R Commander Graphical User Interface

Introduction to Basic Data Formatting/Editing using R 
Commander

Introduction to Descriptive Statistics Using R Commander
Means, proportions

Contingency Tables

Introduction to basic graphics with Rcommander
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What is R? 

Besides being the 18th letter in the 
English Alphabet, R is a language and 
environment for statistical 
computing and graphics. (i.e. free 
version of S)

R commands are executed via 
scripts/syntax in an interactive 
environment. 

R functionality is extended by 
packages that are written for 
specific statistical/ data 
management/ machine learning and 
modeling tasks

Machine 
Learning Other

Functions

Graphics 
FunctionsModeling 

Functions
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What is RCommander?

R Commander is a bundle of R packages that 
essentially overlays a graphical user interface (GUI) 
on top of the R environment.

http://www.r-project.org/index.html
http://www.r-project.org/index.html
http://socserv.mcmaster.ca/jfox/Misc/Rcmdr/Rcmdr-screenshot.html
http://socserv.mcmaster.ca/jfox/Misc/Rcmdr/Rcmdr-screenshot.html
http://www.r-project.org/index.html
http://www.r-project.org/index.html
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Some Key Online Resources 

R-Seek (www.rseek.org): Think Google specifically 
for R.  

Can search for program syntax, packages, R reference 
cards and more specifically related to R.

Quick R (http://www.statmethods.net/): A very top-
level synopsis of R commands organized by function: 

Stats, Input, Graphics, etc. 
Contains both package information (i.e. names, 
descriptions) as well as code snippets.

R Blogspot (http://www.r-bloggers.com/): Meta 
Blogging site specifically dedicated to R users.     
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Working with R

Master Toolbar 
Menu and 

Shortcut icons 

R Console 
Window

R Command 
Prompt

http://www.rseek.org/
http://www.statmethods.net/
http://www.r-bloggers.com/
http://www.rseek.org/
http://www.rseek.org/
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Steps 1 and 2: Launch R and Select Install Packages 
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Steps 3 and 4: 
Select 
Comprehensive R 
Archive Network 
(CRAN) and then 
the Packages you 
need (use ctrl to 
select multiple 
packages)

We want: 
Rcmdr
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Step 5: Load/Launch Packages (Rcmdr)

This list contains all of the packages that 
you have previously installed (or are 
installed by default in R)

Once you install a package, you do not 
need to re-install it.  You just need to load it 
(launch) when you start R.
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A Short Cut for Launching Installed Packages

After you have installed a package in R it stays in 
memory from one launch of R to another. 

However, generally each time you launch R, you 
need to re-load packages (such as R commander).

You can select Packages Load package… and 
select the package name you want to launch (i.e. 
Rcmdr) …OR…

You can type library(PackageName) at the command 
prompt (>) [e.g. > library(Rcmdr)]
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A Quick Overview of R Commander

R Commander allows users who are familiar with the GUI 
of SPSS and EXCEL and JMP to access the functionality of 
R via a window driven graphic user interface. 

While R scripts are generated that correspond to 
commands accessed and selected via a series of drop-
down menu selections (similar to paste syntax in SPSS).

The script versions of the commands appear in the Script 
window and can be copied, edited and rerun by 
highlighting and submitting (like SPSS syntax window).
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Orientation to the R Commander GUI

Toolbars and 
Data Sets Index

Script Pane
(commands pasted here or 

typed)  To execute commands 
entered in this section, 

highlight them and then click 
on the submit button

Output Pane 
Commands pasted in Script 
Window are executed here.  
If using R studio, the output 

window is not included, but is 
part of the R Studio Console 

Window

Messages Pane 
(Warnings/Errors posted here)
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Exploring the R Commander Toolbars

The File Menu Options For:
Loading/Saving Script files

Saving Output and R workspaces

Exiting

Edit Menu Options include:
Copy, cut, paste options for both 
script and output window contents

Right click options are also available 
within each of the panes
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Exploring the R Commander Toolbars, Cont.

The Data menu contains options for:
Creating new R data sets

Loading data sets that exist on your computer already as 
well as data that are contained in other R packages

Importing Data from other Databases/Statistical packages
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Exploring the R Commander Toolbars, Cont.

The Statistics menu contains options for:
Summary Statistics for continuous and categorical data

Means, Proportions, and Variance Summaries/Tests 

Various Nonparametric statistical tests, cluster analysis 
and linear models
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Exploring the R Commander Toolbars, Cont.

The Graphs menu contains options for:
Generating various types of graphs 
including:
Histograms, Boxplots, QQ plots, 3-D plots, 

Scatterplots, Bar graphs, Pie Charts.

Exporting/Saving graphical output

Controlling basic colors of the plots

The Models menu contains options for:
Model summaries, diagnostic statistics, 
hypothesis testing, residual plots and 
confidence/prediction intervals
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Exploring the R Commander Toolbars

The Distributions Menu Contains 
Options for:

Generating random observations, 
probabilities and quantiles for various 
continuous and discrete probability 
distributions 

The Tools Menu Contains Options for:
Loading additional packages into R

Additional R Commander options 
(e.g. font and output controls).
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Example 1 – Importing Excel Files Into R

The Excel 2007 data file called R4SPSSData contains 
data from 15 hypothetical households including 
information on:

household size (Hhsize)
rental status (OwnRent)
internet connectivity (InternetHH)
time in media survey panel (YrsinPanel)
total TV time (in hours) from the past week (TotTVLSW)
Age of panelist (AgeofPanelist) 

For this example, we will demonstrate how to import 
this Excel file into R for further processing and 
analysis and call it “Rtest”
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Example 1, Continued

To Import data from Excel, (and similarly for SPSS, 
Minitab, Stata or other source) follow the menu 
sequence:

DataImport datafrom Excel, Access,…
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Example 1, Continued

Enter the name of the data set – this will be the name you 
use to reference the data set in R (case matters in R; e.g. 
SPSS != spss)

An Open Documents window will appear- in the lower 
right hand corner be sure to select .XLSX as the extension 
(default is .XLS)

• Once you have selected the file and clicked 

the “Open” tab, Select the Excel sheet to 

import.
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Example 1, Continued

If successful, the imported data set name will appear in the 
tool bar and the View and Edit data set tabs will become active.
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Example 1 – DEMO

Import the dataset R4SPSSData into R via R Commander and name the 
dataset Rtest.
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Categorical Variables and R Commander

Variable type attribution is extremely critical for 
maximizing the potential of R commander!

Specifying nominal categorical variables as factors will 
allow them to be accessed as grouping/stratification 
variables, for use in boxplots, to define groups for an 
ANOVA or to control plotting symbols, for example.

Binary variables coded with numbers will not 
automatically be interpreted as a factor (e.g. 1=Male; 
2=Female) so you will need to specify such variables as 
factors and use the numbers or specify the values for the 
levels.
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Example 2

In the R4SPSSData.xlsx file, Internet Connectivity 
(InternetHH) within a sampled household is coded as a 
binary variable with 1 implying internet connection and 
0, no connection.  OwnRent is also a binary variable 
with 1=Own and 2=Rent.

(A) Using R commander, convert the numeric variable 
InternetHH to a factor called Internet with values “YES” and 
“NO”.

(B) Using Rcommander create a 0/1 variable called Own that 
is 1 for Owners and 0 for Renters.  (in this case we will use a 
short cut Own=2-OwnRent).

(C) Create a new variable called TotTWQ to represent the 
quartile in which the case’s TotTWLSW value falls.  
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Example 2(A) - Solution

Step 1:  In R commander, Follow this menu sequence:  
DataManage Variables in Active Data Set 
Convert Numeric Variables to Factors
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Example 2(A), Solution Continued

Select Variable to convert then specify level names 
or numbers and the new name, if applicable.

• If levels are selected, then a 

prompt will appear with as 

many levels as unique values 

for the variable.
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Example 2(A) Solutions Continued

In the next lecture we will learn how to generate basic tables to check 
answers.  But another way we can do a simple check is simply to view the data –
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Example 2(B)

(B) Using Rcommander create a 0/1 variable called 
Own that is 1 for Owners and 0 for Renters.  

We want the value of 2 (renter) to be 0

We want the value of 1 (owner) to be 1

A simple “equation” to convert a 1/2 variable to a 1/0 
variable is:

2 – 2 =  0

2 – 1 = 1

new-1-0-var = 2 – old-2-1-var
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Example 2(B) Solutions Continued
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Example 2(B) Solutions Continued

Here’s what the data set now looks like after adding 
the variable “Own”
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Example 2(C) Solutions 

(C) Create a new variable called TotTWQ to represent the 
quartile in which the case’s TotTWLSW value falls. 

Recall quartiles represent values that evenly split up a distribution 
(dataset) into four parts – each part containing a quarter 
(approximately) of the data…
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Example 2(C) Solutions, Continued

Variable you 
want to BIN!

How do you 
want the new 
variable to be 

labelled?

Number of BINS 
to USE in 

creating the 
new version of 

the variable

Name of New Variable

Choose Equal Count 
Bins for Quantiles
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Example 2(C) Solutions, Continued
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Example 2 (C), Solutions Continued 

To confirm the conversion, you should now see the 
new variable Internet appear as an eligible variable 
for computing frequencies, for example (i.e. can 
apply the table function to the variable Internet)

Following this menu sequence: 
StatisticsSummariesFrequency Distributions
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Example 2(C), Solutions Continued

The Rcommander
Script Window now 
shows the .Table 
command sequence 
to generate the 
frequencies and 
distribution (i.e. 
counts & percentages) 
of sampled 
households who do 
and do not have 
internet (which are 
depicted in the output 
window below)
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Example 3

Part 1: Using R commander, determine how many missing 
values (coded in R as NA) there are for each of the variables in 
the Rtest data set.

Part 2: Using R commander, compute the mean and standard 
deviation for number of hours of TV viewing for the last week 
for sampled households.

Part 3: Compute the average TV viewing for the last week for 
households that have internet and those that do not. 
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Example 3, Part 1 - Solutions

Counts of missing values for every variable in the data set 
(NAs) can be computed by following the menu : 

StatisticsSummariesCount of Missing Values…
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Example 3, Part 2 – Solutions

Step 1: Follow the menu path: 
StatisticsSummariesNumerical Summaries

Part 2: Using R commander, compute the mean and standard deviation 
for number of hours of TV viewing for the last week for sampled 
households.
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Example 3 – Solutions, Continued 

• Step 2: Select the (numeric) variable(s) of interest from the 

Numerical Summaries Pane; Also select the appropriate 

options including computation of:
– the Mean, Standard Deviation and Quartiles.    
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Example 3 – Solutions, Continued 

Notice that the corresponding R command “numSummary” 
appears with the selected options in the R Commander Script Pane.

Notice also that the Mean and standard deviation appear in the R 
Commander Output window.
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Example 3, Part 3 –
Solutions 

Follow the same path to obtain the Numerical Summaries Pane 
and select the numerical variable (TotTVLSW) and Summary 
Statistics Required.  Then click on the “Summarize by Groups 
Tab” and then select the grouping variable…

Caution:  If the grouping 
variable you need does not 
appear in the list, check to 
see that that variable was 
declared a factor as 
described in Example 2.

Part 3: Compute the average TV viewing for 
the last week for households that have 
internet and those that do not. 
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Example 3, Part 2 – Solutions, Continued

Notice that the script window has an additional 
numSummary call with a “groups” option added 
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Example 4 – Contingency Tables!

Do a higher proportion of renting HH have internet 
compared to owning HHs?

Is there a significant association between Household 
Ownership Status and Internet Connectivity?
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Example 4 - Solutions

These questions can be answered by computing a 2-by-2 
contingency table using OwnRent and InternetHH.  

We will also compute a Fisher’s Exact test of association 
(or Chi squared test of association) between these two 
variables.  

In R Commander, follow the menu path: 

Statistics Contingency tablesTwo way tables…
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Example 4 – Solutions, Continued

Step 2: Select the row and column variables as well as any 
percentages or statistical tests that are desired. 

Step 3: Here we want to know 
an attribute of Owners/Renters, 
so I have selected this variable 
as the row and InternetHH as 
the column; 

Consistent with this logic, I 

have also requested row 

percentages.  Chi squared 

and Fischer’s Exact tests 
have also been checked
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Example 4, Solutions Continued
.Table <- xtabs(~OwnRent+InternetHH, 

data=Rtest)

.Table

rowPercents(.Table) # Row Percentages

.Test <- chisq.test(.Table, 

correct=FALSE)

.Test

remove(.Test)

fisher.test(.Table)

remove(.Table)

> .Table <- xtabs(~OwnRent+InternetHH, data=Rtest)

> .Table

InternetHH

OwnRent NO YES

Own         3   7

Rent         3   2

> rowPercents(.Table) # Row Percentages

InternetHH

OwnRent NO YES Total Count

Own        30  70   100    10

Rent        60  40   100     5

X-squared = 1.25, df = 1, p-value = 0.2636

> fisher.test(.Table)

Fisher's Exact Test for Count Data

data:  .Table 

p-value = 0.3287

alternative hypothesis: true odds ratio is not 

equal to 1 

95 percent confidence interval:

0.01692169 4.29385832 

sample estimates:

odds ratio 

0.3129331

Rcommander 

Script Window 

Contents

Output Window 

Contents
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Graphics in Rcommander

R in general is known for it’s extensive graphical 
capabilities and language (ggplot) that provide an 
unprecedented level of customization (and coding).  

Rcommander has a moderate number of supported 
graphical procedures that are built in.  These graphs can be 
customized with edits you can provide to the general 
syntax that is generated by Rcommander. 

The color palettes can be customized for many of the plots.

Generally, plotting symbols, lines types and other plot features 
have predefined defaults built in.  
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Graphics in Rcommander, Continued

Reference for Colors in R (i.e. color names/numbers and RGB’s) 
http://research.stowers institute.org/efg/R/Color/Chart/ColorChart.pdf

col= #

1 2 3 4 5 6 7 8

http://research.stowers-institute.org/efg/R/Color/Chart/ColorChart.pdf
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Graphics in Rcommander: Histograms

Rcommander can generate histograms for any continuous 
variable in your dataset.  Some customization is available through 
the Rcommander window interface and other customization is 
easily available through revising the generated syntax.

Both frequency and relative frequency histograms are available.  
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Histograms, Continued
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Bar graphs with Rcommander
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Scatterplots in Rcommander

Plots can add Least 
squares regression lines 

or a smoothed, loess 
line.  If you choose 

smooth line, you can 
adjust the “bandwidth” 

in the span slider.
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Saving Graphs: Method 1 – Inside R Console

In general, Rcommander produces no graphical output inside its own 
output window.  Instead you can find all graphs within the main R 
console window. 

Click on the boarder to 
make this panel “Active”
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Saving Graphs – Method 2: Via Rcommander
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Example 5 

(a) Using the Rtest dataset plot side-by-side boxplots for 
the ages of panelists by whether or not they live in internet 
households.  Make the boxplots “purple”.

(b) Using this same dataset, plot a scatterplot of the total 
television viewed in the last sweeps week by the number of 
years they panelist has been on the panel.  

For this scatterplot be sure the to include marginal boxplots

Make the plotted points sized at 1.8

Add a title to the plot ‘TV viewing by Years in Panel’
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Example 3.1(d) Solutions

Follow this menu sequence/steps:
GraphsBoxplot…

Then select “AgeofPanlist” in the Variable Window

Then click “Plot by Goups” and select InternetHH, then OK.

In the Rcommander script window, add, col=‘purple’ inside the 
Boxplot syntax.  Hightlight the entire statement and click submit.
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Example 5(a) Solutions Continued
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Example 5 (b) Solutions 

Follow this menu 
sequence/steps:

GraphsScatterplot…

Then select “YrsinPanel” for x

Select “TotTWLSW” for y

The select options to select 
marginal boxplots on the left, enter 
the title ‘TV viewing by Years in 
Panel’ and change point size to 1.8 
(both on the right).
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Example 5(b) solutions Cont. 
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Thank You!

TBuskirk@m-s-g.com

tdbuskirk@gmail.com

314-695-1378

www.m-s-g.com

mailto:TBuskirk@m-s-g.com
mailto:tdbuskirk@gmail.com
http://www.m-s-g.com/
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Appendix

A0 – Installing R 

A1 – Take home example for variable conversion and 
basic frequency tables.

A2 – Take home example for frequency distributions

A3 – Graphical plotting symbols and lines reference 

A4 – Other R packages for Descriptive Statistics 

A5 – Linear Regression using Rcommander
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A0: Installing R

R
http://cran.r-project.org/bin/windows/base/
Current version as of June 2014:

http://cran.r-project.org/bin/windows/base/

RStudio
http://rstudio.org/download/desktop
Current version as of June 2012: 

http://download1.rstudio.org/RStudio-0.96.231.exe

http://cran.r-project.org/bin/windows/base/
http://cran.r-project.org/bin/windows/base/
http://rstudio.org/download/desktop
http://download1.rstudio.org/RStudio-0.96.231.exe
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A0: Download R
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A0: Download R
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A0: Download R http://cran.r-project.org/bin/windows/base/
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A0: Install R

http://cran.r-project.org/bin/windows/base/
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A1– Basic Recoding and Frequencies

Convert the OwnRent variable into a factor with the 
levels 1 corresponding to OWN and 2 to RENT.

What proportion of sampled households are renters?
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Appendix A1– Demo Video

Roll over the 
Graphical Image 

at the bottom 
and then press 

the play triangle 
in lower left
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Appendix 2: Working more with Frequency 
Distributions

Are there any outliers in the Number of TVs per 
household?  Don’t cheat – use an interactive boxplot 
here.

What is the 75th Percentile (i.e. 3rd quartile) for the 
number of TVs owned?

Which type of household – owner or renter – has a 
longer tenure on the panel, on average?
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A2– Video Solutions
• Are there any outliers in the Number of TVs per household

Roll over the 
Graphical Image 

at the bottom 
and then press 

the play triangle 
in lower left
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A2, Solutions Cont.
• What is the 75th Percentile (i.e. 3rd quartile) for the number of TVs owned?

Roll over the 
Graphical Image 

at the bottom 
and then press 

the play triangle 
in lower left
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A2, Cont.
• Which type of household – owner or renter – has a longer tenure on the panel, on average?

Roll over the 
Graphical Image 

at the bottom 
and then press 

the play triangle 
in lower left
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A2, Cont.
• Which type of household – owner or renter – has a longer tenure on the panel, on average?

Roll over the 
Graphical Image 

at the bottom 
and then press 

the play triangle 
in lower left
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A2 Cont.



38

4/26/2016 75
4/26/2016 TRENT D. BUSKIRK, PH.D.  R FOR SPSS USERS AAPOR WEBINAR 75

A3: Basic plotting symbols in R

Plotting Symbols other Parameters in R plots:  http://bit.ly/1Mcxape

Color Chart for R plots:   http://bit.ly/1RKe7m6
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A4: Some Other R packages for Descriptive Statistics

There are hundreds of R packages that extend the analytic 
and graphics capabilities of R.

These packages are like “mini” SPSS modules.
Some popular examples include:
 lessR – streamlined and simplified syntax for General Data Analysis
Boot – bootstrap statistics
NLME – nonlinear models
RandomForest – random forest classification models
Lattice – scatterplot matrix and other graphical enhancements
MatchIt – statistical matching models
 Ggplot 2 – enhanced graphics capabilities/forms
 Survey – design and analysis of survey samples
 PASWR – Basic statistics package that contains functions for 

nonparametric analysis and Exploratory Data Analysis.  

http://bit.ly/1Mcxape
http://bit.ly/1RKe7m6
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A4: Additional Examples of Packages focused 
on Descriptive Statistics

• The Hmisc package:

>library(Hmisc)

>describe(mydata) 

REQUESTS: n, nmiss, unique, 

mean, 5,10,25,50,75,90,95th 

percentiles,5 lowest and 5 

highest scores

The psych package:

>library(psych)

>describe(mydata)

>describe.by(mydata, grouping variable)

REQUESTS: item name ,item number, nvalid, 

mean, sd, median, mad, min, max, skew, 

kurtosis, se 
(Summary statistics as a whole or by the grouping variable)

The pastecs package:

>library(pastecs)

>stat.desc(mydata) 

REQUESTS: nbr.val, nbr.null, 

nbr.na, min max, range, sum, 

median, mean, SE.mean, 

CI.mean, var, std.dev, coef.var
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A5: Regression Modeling in Rcommander

Step 1: Select the type of model under the Statistics 
Menu:  Statistics MenuFit ModelLinear Regression

R names 
models as 

Objects and 
stores model 

results in 
these objects

http://cran.r-project.org/web/packages/Hmisc/index.html
http://cran.r-project.org/web/packages/psych/index.html
http://cran.r-project.org/web/packages/pastecs/index.html
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A5: Linear Regression in Rcommander

Step 2:  Select the form of the model – predictors 
and outcome variables

For Multiple Linear 
Regression, select 

multiple predictors 
using the “CTRL” key
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A5: Linear Regression in Rcommander

Step 3:  Summarize model and explore model fit 
diagnostics
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A5: Linear Regression in Rcommander

Summarize 
Function presents 
overall model fit 
and coefficient 
estimates table

Provides choices for 
model fit and 

summary plots

Provides choices for 
model fit and 

summary plots
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A5: R, Rcommander Regression Output 


